
ON THE WEB
� The tutorial fi les are in 

the Stop Press section of

www.3dworldmag.com

hen you�re starting out in 3D, there�s nothing 

like a graded project to test your skills. So 

this issue, we�re going to create the antique 

pocket watch above from scratch. We�ll start 

by focusing on the modelling work in detail, then go on to 

explore texturing and lighting, covering more and more 

ground as we do so. See how far through you can get!

For the tutorial, we�ll be making use of Cinema 4D�s various 

polygon modelling tools, and some of the useful new objects and 

instancing tools in the MoGraph module. (If you don�t have MoGraph, 

we�ll suggest alternative workarounds.) Modelling complete, we�ll 

explore the creation and application of shader-based textures to 

create an authentic gold fi nish for the watch, with the addition of 

grime bitmaps and lots of procedural noise, and a silky red material 

for the background cloth. Lastly, we�ll touch on lighting and rendering.

Along the way, we�ll be teaching you some techniques you can 

use in your own projects. Some of the biggest giveaways that an 

image has been created using 3D are pristine objects with unfeasibly 

sharp edges; perfectly smooth surfaces with no fl aws or fl uctuations; 

and squeaky-clean surface materials with no traces of dirt and grime. 

This might seem like a challenge to counter, but use of HyperNURBS 

and careful knife cuts during modelling – as well as a few simple 

additions to the model�s materials using procedural noise, and the 

odd �dirty� bitmap – can create something that looks authentic.

Full-size screenshots are provided at the Stop Press section 

of the 3D World website (www.3dworldmag.com), so that you 

can refer to key settings in more detail. The supporting fi les on the 

site also include pre-built textures, and the fi nal scene fi le. If you get 

stuck, try loading this in and �reverse engineering� our solution.

Adam Benton is a freelance illustrator from the UK. He has 

been using Cinema 4D professionally for six years, and 

creates tutorials and illustrations for various magazines

www.kromekat.com
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This month, we bring you a complete Cinema 4D project: to model, texture and light this elegant antique 
pocket watch. The walkthrough starts out gently, then speeds up to stretch your skills  BY ADAM BENTON

Watch the clock  
 CINEMA 4D 

TUTORIALS | Model and texture a watch

FACTFILE
 

FOR

Cinema 4D 

DIFFICULTY

Elementary / Intermediate

TIME TAKEN

2-3 hours

ON THE WEB

•  Full-size screenshots

•  Supporting scene fi les 

and textures

ALSO REQUIRED

MoGraph module (ideal, 

but not essential)
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STAGE ONE | Modelling the body of the watch

There are a few tools you will be using regularly 

throughout the modelling process, so in the 

Structure menu, click on the top bar to tear off the 

menu palette. Right-click on the fl oating menu, untick Text, 

and select Transpose to make the icons horizontal. Finally, 

increase the Icon Size to Large Icons, then drag the Icon 

palette into the interface and dock it above the timeline.

01
Make the Cylinder editable (press [C]). Then in Poly 

Mode (select the Use Polygon Tool icon), select all 

the polygons above the central axis. These will be 

duplicated and used for a couple of elements within the model. 

From the Functions menu, select Split to create a copy of just 

these polygons. Next hide this new object by clicking the 

visibility dots next to the copied object in the Objects Manager.

03

After tightening the main edges, add a couple of 

inset ridges to the main upper face using the Knife 

tool, with Mode set to Loop as before. To do this, 

create two cuts close together, then use Loop Selection to 

select the newly created polygons, and use the Extrude tool 

to extrude downwards. Before moving, changing the tool or 

deselecting the extrusion, increase the Subdivision of the 

extruded polygons in the AM to 2. This sharpens the ridge.

07

�
Model and texture a watch | TUTORIALS

Left-click to open the Primitive object palette (the 

cube icon), and select a Cylinder. In the Attributes 

Manager (AM) open the Object Properties tab and 

reduce its Height to 30m, and change the Radius to 100m. 

Next reduce the Rotation Segments to 24, and in the Caps 

tab, activate the Fillet option by checking the checkbox, then 

set Segments to 3 and Radius to 14m.

02

EXPERT TIP
V is for versatile
If you hold down the [V] key, a 

menu will appear under your cursor, 

which gives you quick access to a 

number of tools and options used 

within a typical modelling session in 

Cinema 4D. From the mouse-centred, 

diamond-shaped array of headings 

that appears, you can very quickly 

and easily access options �on 

location� instead of moving to 

the top of the interface and using 

menus there. Each option contains a 

sub-menu of tools and commands. 

This is a highly intuitive way 

to switch through the various 

selection tools such as Loop, Fill, 

Ring and Outline Selection.

i

With the polygons still selected, choose the Scale 

tool (press [T]). Use the Y-axis handle and drag 

downwards to compress the polygons until they are 

all fl at. Next, use the Loop Selection option to deselect the 

outer two rings of polygons. (On a Mac, hold down [Apple] 

to deselect; on a PC, hold [Ctrl]. Hold [Shift] to add to the 

selection.) Now press [D] to select the Extrude tool, and drag 

right with the mouse to extrude the polygons.

04
In the Objects Manager (OM), name the active Cylinder 

�Body� and the non-visible Cylinder �Lid�. Select 

both �Body� and �Lid�, then hold down [Option]+[G] 

/ [Alt] + [G] to group them under a Null Object. From the top 

icon palette, select a HyperNURBS (HN) object and drop the 

Null Object onto it. (This places the Null Object beneath the 

HyperNURBS in the hierarchy.) Now these and any further 

objects added to the Null will be smoothed by the HN.

05

The smoothed shape needs tightening up. Select 

Body, then from the tools palette you docked earlier, 

select the Knife tool. In the AM, set the tool�s Mode 

to Loop, and deactivate Restrict To Selection. Make cuts 

running around the entire face of the watch, close to the 

edges marked [1] and [2] above, to create tighter folds. On 

the outer rim [3], use Loop Selection (in Edge Mode) to move 

the existing edges closer to the outer edge to tighten it.

06

EXPERT TIP
Text without MoGraph
Overleaf, we�ll show you how to place 

the numerals on the watch face using 

the MoGraph module. If you don�t have 

MoGraph, you can do this by hand: the 

simplest, but most labour-intensive, 

solution. In the Spline palette, locate 

the Text Spline. The text itself, the 

font and the scale can be edited via 

the Attribute Manager. From the 

NURBS palette, select an Extrude 

NURBS and drop the Text Object into 

it in the AM. The depth of the text can 

be altered via the Movement fi elds; in 

the Caps tab, it is possible to add 

fi llets. You can then move the 

numerals into position manually using 

the Move and Rotate tools.

i

1
2

3
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For the watch face numerals, we�ve used MoGraph. Go 

to the MoGraph menu, and select the Text Object. You 

need a separate Text Object for each numeral. Set up 

the fi rst with a suitable font, type in the numeral (start with 

12), then duplicate and edit each one to create the numerals 

from 1 to 11. Select a Cloner Object from the MoGraph menu 

and drop all of the Text objects under it in the OM.

08
Next, add the minute indicators. Start with a Cube 

primitive; scale it so that it becomes rectangular; 

and give it a slight bevel. Next, select another Cloner 

Object from the MoGraph menu, and drop the Cube into it. 

Using similar settings to the numerals, but with a Count of 60, 

make an array of �minutes� around the outer edge of the face. 

Do the same with the hour indicators using a scaled Cylinder.

10

The extruded polygon will form the hand itself. Using 

the Knife tool in Loop Mode, add three lateral cuts 

across the extruded watch hand. In Edge Mode, using 

the Loop Selection Tool, select the central edge loop and scale 

up in the X-axis to form the diamond shape on the hand. Next 

select the end polygon in Polygon Mode, and scale down in the 

X-axis to make more of a point at the end of the hand.

14

With the Cloner Object selected, in the AM, set the 

Mode to Radial, Count to 12, and Plane to XZ. With 

the watch base visible, alter the Radius until it fi ts 

as desired. Finally, by multi-selecting ([Shift]-selecting) all of 

the Text Objects, alter their size. Add a slight bevel to their 

top faces if you want. (To do this, you�ll need to make the Text 

Objects editable, and use Structure > Bevel.)

09

TUTORIALS | Model and texture a watch

Create a primitive Cylinder; this will be the minute 

hand. Press [C] to make the Cylinder editable. Scale 

it to match the image above. Change the Rotation 

Segments to 12. Rotate the Cylinder axis 15 degrees in the 

X-axis using the Object Axis Tool. Then using the Model Tool 

rotate the entire cylinder back 15 degrees. Next select the 

polygon facing 12 on the watch and extrude this polygon.

13

STAGE TWO | Adding numerals and markers to the face

Place the watch hand in a new HN object to smooth 

it. Add further loop cuts around the edge of the 

hand, as in Step 6. This will harden up its edges while 

retaining smooth curves for its overall form. To create the hour 

hand, duplicate the minute hand, and using the Loop Selection 

tool, select the three polygon loops towards the end of the 

hand. Use the Move Tool in the Z-axis to resize the new hand.

15

�

STAGE THREE | Creating the hands and the lid

Next, let�s make a separate seconds dial. Since the 

elements are in place for the main dial�s digits and 

indicators, you can duplicate these and re-edit them 

for their new purpose. Group all the Cloned Objects of the main 

dial into a Null, and rename it �Main Dial�. Copy and paste this 

dial, renaming the duplicate �Seconds Dial�. Rescale the new 

dial as shown in the image above.

11
Remove six of the Text Objects under the new 

Cloner Object, by selecting them in the OM and 

hitting [Delete]. Edit the remaining six to display the 

numbers 10, 20, 30 and so on up to 60. To create a base for 

the dial, select a Cylinder object from the menu, fl atten it to 

a minimal height, then move it just below the new numerals 

using the Transfer tool, as explained in the next Expert Tip.

12

EXPERT TIP
Using the Transfer tool
The Functions menu contains an 

extremely useful tool which is often 

overlooked by new users of C4D. 

Transfer, as the name suggests, 

allows an object or group of objects, 

to be moved to the location of 

another object or group. It can also 

adjust the object you wish to move 

to the same rotation axis and scale 

as the target object. This can be 

very useful during modelling, since 

it saves a lot of manual alignment 

work in the various viewports, 

especially when the target object 

has been placed in awkward 

non-planar rotations.

i
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TUTORIALS | Model and texture a watch

Add a new Cylinder object to form the central pivot 

for the hands, as shown above. After some more 

loop cuts, use the Bevel tool to raise the inner and 

outer polygons to add a little more detail. For the seconds 

hand, copy the hour hand, then rescale it and Transfer it to its 

appropriate location on the seconds clock face.

16
To create the tiny hinge, create a new Cylinder, scale 

it as shown above and move it to the bottom end of 

the watch (where the number 6 is on the main dial). 

In the Object Manager, drop the Lid object under it. Now use 

the actual hinge axis point for rotating the lid. With the Hinge 

object selected, rotate the lid open.

18

Copy and paste the winder group into the main watch 

document and move and scale the group into place at 

the top of the watch. Finally, check that everything is 

HN smoothed. You could also add some fi nishing touches such 

as a maker�s name using a Text Object under the hour hand 

and some additional loop cuts to tighten up the lid edge and to 

create an indent for the glass lid on the watch base. 

23

Make the Lid object visible and position it as shown 

above. Add a couple of loop cuts to the top polygons. 

With the Loop Selection tool and the Move Tool, raise 

both inner loops slightly in the Y-axis. With only the inner circle 

selected, raise this a little further, creating a domed shape. 

Make a copy of the lid for later and make it invisible in the OM.

17

Press [D] to activate the Extrude tool, and with an 

Offset of around 4m, hit Apply in the AM. Double-click 

on the Selection Tag to recall the previous selection, 

then extrude again. Finally, select the upper polar circle of 

polygons, and extrude them down -4m. Add some indents to 

the Cylinder using the Knife and Extrude tools. Move the three 

objects into position, group them and place in a HN object.

22

STAGE THREE (Continued) | Creating the hands and the lid

STAGE FOUR | Adding the fi nal modelling touches

Next, you need to make the winder and ring for the 

watch. Starting with a fresh document (File > New) 

add and make editable Cylinder, Sphere and Torus 

objects. Use the Live Selection tool to select alternate lines 

of polygons on the Sphere, as shown above. In the Selection 

menu, choose Set Selection to create a Selection Tag, then 

Selection > Invert. Deselect the top and bottom polar polygons.

21
To make the lid more realistic, you need to add some 

thickness. Select all of the polygons and Extrude 

inwards with Create Caps checked. The colour of 

the new polygons (blue), means the normals are all inverted. 

(That is, the polygons face in the wrong direction.) To make 

them all face outwards again, select Reverse Normals from 

the Functions menu.

19
Make the second copy of the Lid visible and rename 

it �Glass�. Scale it to reduce its size and position it so 

that it just covers the edges of the watch face. Then 

select and extrude the outer rings of the polygons. These 

will form the metal rim of the watchglass. Add a hinge for the 

watchglass to the left side of the watch face, using the same 

method as in Step 18.

20

EXPERT TIP
Selective memory
Selection Tags are used for a number 

of things in C4D, including restricting 

textures to specifi c polygons and 

restricting polygons to specifi c bone 

deformers. You can use them when 

modelling too: for instance, when you 

wish to make multiple modifi cations to 

alternate poly groups which would be 

tedious to have to keep reselecting 

manually. By making a Polygon 

Selection, you are in effect creating 

a memory or snapshot to which you 

can return later, thus eliminating a lot 

of manual selection and saving time. 

Once you have no further need for 

that selection, just delete the tag.

i
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Model and texture a watch | TUTORIALS

The next stage is to create shaders for the watch 

elements. We want this to be an antique gold watch, 

so we will start with the gold material. Double-click 

in the Materials window to create a new material, and then 

double-click again on the new Mat icon to open the Material 

Editor. Copy the settings above. In the Color channel, go to 

Texture > Effects > Lumas. Increase Brightness to 100%.

24
Now add Refl ection (by ticking the Refl ection 

channel), set Brightness to 25% and Color to RGB 

212, 191, 110. The �anisotropic� effect Lumas creates 

is ideal for machined/lathed metal. Click Lumas and check the 

Anisotropy setting to activate it. Copy the settings shown in 

the screenshot above. Now duplicate the material and apply it 

to the polygons behind the numerals by using a new Selection 

Tag. To create some variation in the tone of the gold on the 

watch face, experiment with the Anisotropy > X Roughness and 

Anisotropy > Y Roughness settings.

26

Next, right-click the Sky object and choose Cinema 

4D Tags… > Compositing. In the Compositing Tag this 

creates, turn off the Seen By Camera option. To make 

the engraved gold shaders a little more convincing, add a layer 

to their Bump channels. (More details on how to do this in Step 

31.) Inside the layer, add Noise, then drop �Noise� under �Celtic�. 

Set the Noise to 98% to make the refl ections distort a little.

31

To apply the shader, select the polygons of the central 

face, then choose Selection > Set Selection to create 

a Selection Tag. Apply the material by dragging it 

from the Material Editor to the Body object in the OM. Drop the 

Selection Tag (in the OM) onto the material�s Selection fi eld 

in the AM. This restricts the material to just those polygons 

contained in the tag. Deselect the tag again. In the Material 

Editor, click Lumas, and edit the shader Color to RGB 198, 172, 

84; set Specular 2 to RGB 255, 227; 160; and set Specular 3 to 

RGB 193, 168, 92.

25

STAGE FIVE | Texturing and lighting the watch

Let�s age the gold a bit. In the Material Editor, check 

the Diffusion channel, then click on the arrow next 

to Texture. Select Layer. The original noise is stored 

in a layer. Now click the layer and apply the �Grunge2� image 

(included in the fi les on the web). Change the drop-down from 

Normal to Multiply to multiply it over Noise and set it to 50%. 

Set Mix Strength to 55%. Repeat for the other gold materials.

32

�

Refl ection has been used in all of the gold materials, 

so now you need something to refl ect. We�ll use an 

HDRI image for this. Select a Sky object from the 

Lights Palette, then create a new material and drop it onto 

the Sky tag. In the Luminance channel, load DH217SX.hdr 

(included on the web), and click the thumbnail of the image. 

Lower the HDR Gamma to 0.6. Turn off all the other channels.

30

To apply the engravings, select the fi rst gold material 

you created. In the Material Editor, turn on the Bump 

channel. Next load the Celtic.psd image and adjust 

the Strength to 30%. Now change the projection from UVW 

Mapping to Cubic (in the AM). You can scale the engravings 

using the Use Texture Tool as required. Repeat the process for 

the second gold material you created, using Celtic Border.psd.

29
Duplicate the material again and uncheck Anisotropy. 

This new material will be applied to all of the other 

gold parts on the watch body. But the gold looks too 

even and clean. Select each gold material, check the Diffusion 

channel, and select Texture > Noise to apply procedural noise. 

Use the settings shown above for the noise values; and use a 

slightly different Global Scale to vary each gold shader.

27
To distress the gold still further, apply another Noise 

in the Luminance channel of each gold material. Turn 

on Luminance, set Brightness to 0%, apply Noise with 

a Mix Strength of 5%, set Noise type to Wavy Turbulence and 

vary the Global Scale. Now let�s apply some engravings to the 

watch. We�ve created two designs in Photoshop (Celtic.psd and 

Celtic Border.psd) for you to use. You can fi nd the fi les online.

28
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TUTORIALS | Model and texture a watch

The anisotropic highlights aren�t showing up with 

the area shadow in the fi rst light you created. To 

fi x this, turn off the Specular option in the General 

tab of the AM. Create a copy of the light, and in the copy, 

turn on its Specular attribute, but turn off Diffuse, and 

set its Shadow to Area. Now you get the best of both area 

shadows and anisotropic highlights on the various materials. 

Experiment with the settings for the Global Illumination 

Strength and the Intensity of the lights to fi nd a good 

balance between long render times and blown-out highlights 

in the rendered image. As a fi nal touch, you could add your 

signature to the watch face of your fi nished antique pocket 

watch. Now the modelling, texturing and lighting is complete, 

you could even animate the hands, and watch time fl y by! �

38

STAGE FIVE (Continued) | Texturing and lighting the watch

Next, we will create a silky fabric for the watch to sit 

on. Create a Plane Primitive with 70 x 70 segments, 

and scale it appropriately. In the Structure menu, 

select the Brush tool. Using the brush settings shown above, 

sculpt the geometry of the plane around the watch. Add the 

plane to a HN object. Make a new material and open it in the 

Material Editor. In the Color channel, set the new material�s 

texture to Fresnel.

35

Turn on Global Illumination in Render > Render 

Settings. Add a Target Light from the Lights palette, 

matching the position of the left light above. Set 

Color to RGB 212, 207, 255, Intensity to 75% and add an area 

shadow (Shadow > Area in the AM). Add another Target Light to 

match the right light�s position above, set Shadow Maps (Soft) 

and Intensity to 28%, and Color to RGB 255, 176, 88.

37

Now create Selection Tags for both the glass and rim 

materials of the watchglass. For the glass, create 

a new material. In Transparency, set Brightness to 

98%, Refraction to 1.5, and turn Fresnel on. In the Luminance 

channel, add Noise set to Wavy Turbulence, and set Global Scale 

to 300%. Next layer on an inverted grunge map. (�Grunge2b� in 

the fi les online: use the same procedure as Step 32.) Set this 

to Screen, set Mix Strength to 50% and Brightness to 0%.

34

Edit the gradient by clicking on it and copying 

the colours shown in the screenshot above. Next, 

add Noise to the Bump channel with Strength set 

to 10%, Global Scale to 10%, change Space to World and 

Relative Scale to 100%, 100%, 1%. This will give the silk 

a nice subtle roughness. Apply the shader to the fabric 

geometry. To make the watch�s numerals, hands and markers 

stand out from the gold, create a new material, colour it dark 

grey or black, and apply it. You can experiment with your own 

settings, or copy those in the fi nal scene fi le on the web.

36

Let�s add a hallmark. Copy the non-engraved gold 

shader. In the Material Editor, turn on Displacement, 

load HallMark.psd and match the settings to the 

screenshot. In Alpha, load HallMark_ALPHA.psd; turn on Invert. 

In Diffusion, load HallMark.psd; set Mix Strength to 100%. Use 

a Selection Tag to apply the hallmark. Change UVW Mapping 

to Flat and use the Use Texture Axis Tool with Lid selected to 

position the hallmark appropriately. Turn off Tile.

33
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